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4. คณะผู้ด าเนินงาน 

หัวหน้าการทดลอง นายธีรภัทร์ ธรรมไชยางกูร  สังกัดศูนย์เทคโนโลยีสารสนเทศและการสื่อสาร 

        ผู้ร่วมงาน นายสุรพงษ์ ประสิทธิ์วัฒนเสรี สังกัดศูนย์เทคโนโลยีสารสนเทศและการสื่อสาร 
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                   นางสาวนครินทร์ทิพย์ พุทธสิทธิ์ สังกัดศูนย์เทคโนโลยีสารสนเทศและการสื่อสาร 

                   นายวีรศักดิ์ ขุนช านาญ สังกัดศูนย์เทคโนโลยีสารสนเทศและการสื่อสาร 

                   นางสาวนวลมณี พรหมนิล สังกัดศูนย์เทคโนโลยีสารสนเทศและการสื่อสาร 

                   นางสาวสุวชิา อ่อนเฉียบ สังกัดศูนย์เทคโนโลยีสารสนเทศและการสื่อสาร 

                   นายยรรยง พันธ์พฤกษ์ สังกัดศูนย์เทคโนโลยีสารสนเทศและการสื่อสาร 

                   นางสาวอมรรัชฏ์ คิดใจเดียว สังกัดส านักวิจัยพัฒนาการอารักขาพืช 
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5. บทคัดย่อ  

การพัฒนาโมเดลการจ าแนกภาพโรคที่แสดงอาการบนใบมันส าปะหลังใช้กลุ่มตัวอย่างภาพจาก

แฟ้มข้อมูลใบมันส าปะหลัง จ านวน 500 ภาพ ก าหนดขนาดภาพเท่ากับ 224 x 224 พิกเซล แปลงภาพทั้งหมด

จาก RGB เป็นภาพระดับสีเทา (Gray Scale) สกัดข้อมูลตัวแปรจากภาพโดยวิธีวิเคราะห์เมตริกซ์การปรากฎ

ร่วมของระดับสีเทา (Gray-Level Co Occurrence Matrix : GLCM) ได้ตัวแปร (Feature) ได้แก่ ค่า Contrast, 

Correlation, Entropy, Angular Second Moment และ Inverse Difference Moment น าข้อมูลทั้งหมด

แบ่งเป็น 5 คลาส คือ 0) ต้นปกติ 1) โรคใบไหม้ 2) โรคใบจุดสีน้ าตาล 3) โรคแอนแทรคโนส 4) อาการใบด่าง 

สร้างโมเดลจ าแนกโรคที่แสดงอาการบนใบมันส าปะหลัง ด้วยภาษา Python โดยใช้การจ าแนกประเภทแบบ 

Support Vector Machine (SVM) แบ่งข้อมูลภาพเป็นข้อมูลฝึก 75 % และข้อมูลทดสอบ 25 % ผลลัพธ์ที่ได้

มีค่าความถูกต้องของการจ าแนก 66 % 

 

Abstract 

 Developing Cassava leaf disease images classification model were used the sample 

size of 500 images from the dataset of images of diseased and healthy cassava leaves 

collection. The images were resized to 224 x 224 pixel. The whole RGB images were converted 

to Gray Scale images. Feature extraction using Gray – Level Co Occurrence Matrix (GLCM) were 

Contrast, Correlation, Entropy, Angular Second Moment and Inverse Difference Moment. Label 

mapping encoded categories to 5 classes; 0) Healthy 1) Bacterial Blight (CBB) 2) Brown Streak 

Disease (CBSD) 3) Anthracnose and 4) Mosaic Disease (CMD). Building classification model used 

Support Vector Machine (SVM) classifier of 75% training data and 25% testing data. The result 

got 66% for accuracy.  

 

6. ค าน า                                  

  ประเทศไทยมีการปลูกมันส าปะหลังมากที่สุดในอาเซียน ตามด้วยอินโดนีเซียและเวียดนาม 

(ส่วนมากส่งออกเป็นผลิตภัณฑ์มันส าปะหลัง เช่น มันเส้น และแป้งมัน) ผลผลิตมันส าปะหลังปี 2563 (เริ่มออก

สู่ตลาดตั้งแต่เดือนตุลาคม 2562 – กันยายน 2563) คาดว่ามีพ้ืนที่เก็บเกี่ยว 8.92 ล้านไร่ ผลผลิต 29.00 ล้าน

ตัน ผลผลิตต่อไร่ 3.25 ตัน เมื่อเทียบกับปี 2562 มีพ้ืนที่เก็บเกี่ยว 8.67 ล้านไร่ ผลผลิต 31.08 ล้านตัน และ

ผลผลิตต่อไร่ 3.59 ตัน พบว่า พ้ืนที่เก็บเกี่ยวเพ่ิมขึ้นร้อยละ 2.88 ผลผลิต และผลผลิตต่อไร่ ลดลงร้อยละ 6.69 
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และ 9.31 ตามล าดับ โดยปี 2563 ปริมาณการส่งออกผลิตภัณฑ์มันส าปะหลัง 6.73 ล้านตัน มูลค่า 79,414 

ล้านบาท เมื่อเทียบกับปี 2562 ที่มีปริมาณส่งออก 6.29 ล้านตัน มูลค่า 78,622 ล้านบาท พบว่า ปริมาณ และ

มูลค่าเพ่ิมขึ้นร้อยละ 7.00 และร้อยละ 1.01 ตามล าดับ (ส านักวิจัยเศรษฐกิจการเกษตร, 2563) เนื่องจากในปี 

2562 สภาพอากาศร้อนจัดและแห้งแล้ง ปริมาณน้ าน้อยกว่าปี 2561 ส่งผลต่อการเติบโตของพืช ท าให้ผลผลิต

ลดลง รวมทั้งฝนที่ล่าช้า ภาวะฝนทิ้งช่วง และผลกระทบจากพายุโซนร้อน พ้ืนที่เพาะปลูกได้รับความเสียหาย 

นอกจากนี้ยังมีการระบาดของโรคใบด่างมันส าปะหลัง ท าให้ผลผลิตได้รับความเสียหายรวมทั้งการส่งออกสินค้า

เกษตร (ส านักวิจัยเศรษฐกิจการเกษตร, 2562) โดยแหล่งเพาะปลูกที่ส าคัญ คือ จังหวัดนครราชสีมา 

ก าแพงเพชร ชัยภูมิ กาญจนบุรี และอุบลราชธานี ปัจจัยส าคัญอย่างยิ่งในการผลิตมันส าปะหลังให้ได้คุณภาพดี 

และผลผลิตสูง คือ การเลือกพันธุ์ที่เหมาะสมกับสภาพพ้ืนที่ การใช้ท่อนพันธุ์ที่สะอาดปราศจากโรคและแมลง

ต่างๆ การรู้จักโรคและแมลงศัตรูพืชต่างๆ การวินิจฉัยอาการจากโรคแมลงได้เบื้องต้น การเลือกใช้วิธีการก าจัด

ศัตรูพืชที่เหมาะสมถูกที่ ถูกเวลา และการเลือกใช้สารเคมีที่ถูกต้องกับโรคในปริมาณที่เหมาะสม โดยเริ่มตั้งแต่

การหมั่นตรวจแปลง และวินิจฉัยอาการของพืชที่พบเบื้องต้นว่าอาการนั้นเกิดจากการขาดธาตุอาหาร เกิดจาก

แมลง หรือเกิดจากโรค ศัตรูพืชบางชนิดอาจจ าแนกได้ยาก โดยเฉพาะโรคพืชมีความส าคัญต่อโครงสร้างทาง

สรีรวิทยาของต้นพืช ซึ่งแสดงลักษณะอาการที่ปรากฏให้เห็นเป็นหลักฐาน โรคพืชมีสาเหตุจากเชื้อโรค และส่วน

ใหญ่จะปรากฏอาการให้เห็นบนใบหรือต้นพืช โดยโรคส าคัญของมันส าปะหลังได้แก่ โรคใบไหม้ โรคแอนแทค

โนส โรครากปม โรคใบจุดสีน้ าตาล โรคใบจุดขาว ซึ่งโรคใบไหม้และโรคใบจุด ในระยะเริ่มแสดงอาการยากต่อ

การแยกด้วยสายตา สามารถท าให้เกิดการวินิจฉัยโรคผิดได้ ดังนั้น การตรวจวัดใบและต้นพืช เพ่ือค้นหาโรคและ

ลักษณะอาการท่ีถูกโรคท าลาย จึงเป็นปัจจัยส าคัญท าให้การเพาะปลูกพืชประสบผลส าเร็จ 

  ปัจจุบันเทคโนโลยีสารสนเทศได้เข้ามามีบทบาทส าคัญในการช่วยวินิจฉัยโรคเบื้องต้น ช่วยลด

ค่าใช้จ่ายและเวลาในการด าเนินการ โดยการประมวลผลภาพ ( Image Processing) ซึ่งเป็นการน าภาพมา

ประมวลผลหรือคิดค านวณด้วยคอมพิวเตอร์ เ พ่ือให้ได้ข้อมูลที่เราต้องการทั้งในเชิงคุณภาพและปริมาณ 

ขั้นตอนในการจ าแนกประเภทของภาพใช้การวิเคราะห์จากการเรียนรู้ของเครื่อง (Machine Learning) เป็น

เทคนิคหรือกระบวนการที่ใช้โปรแกรมคอมพิวเตอร์สนับสนุนการเรียนรู้ เพ่ือพัฒนาหรือปรับปรุงประสิทธิภาพ

การท างานของระบบให้เกิดการเรียนรู้ และน าไปใช้ในการตัดสินใจต่างๆ วิธีการเรียนรู้ของเครื่องโดยใช้  

Support Vector Machine (SVM) ซึ่งเป็นโมเดลที่สามารถวิเคราะห์ข้อมูลและจ าแนกประเภทข้อมูล โดย

อาศัยการหาสมการเพ่ือสร้างเส้นแบ่งแยกกลุ่มข้อมูลที่ถูกป้อนเข้าสู่กระบวนการฝึกให้ระบบเรียนรู้ มีการ

น าไปใช้ในการพยากรณ์การเกิดอาการจากหนอนชอนใบ (Dake and Chengweii, 2006) การพยากรณ์โรครา

สนิมที่ใบของข้าวสาลี (Wang and Ma, 2011) 
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  การพัฒนาโมเดลจ าแนกภาพโรคบนใบมันส าปะหลัง เป็นพ้ืนฐานส าคัญ น าไปใช้ในการพัฒนา

ระบบตรวจวัดและจ าแนกโรค ทั้งนี้เพ่ือให้สามารถช่วยเหลือเกษตรกรท าให้ทราบข้อมูลเกี่ยวกับโรคพืชที่พบ 

สามารถป้องกันก าจัดในเบื้องต้น เพ่ือลดการแพร่ระบาดและความรุนแรงของโรคได้ อีกทั้งยังช่วยลดช่องว่าง

ระหว่างเกษตรกรกับเจ้าหน้าที่ในการให้บริการค าปรึกษา ก่อให้เกิดประโยชน์ในการติดตามการปลูกพืชใน

ระบบแปลงใหญ่ และโมเดลที่พัฒนาขึ้นยังสามารถพัฒนาต่อยอดในด้านอื่น ๆ ได้ประสบความส าเร็จต่อไป 

 

7. วิธีด าเนินการ  

- อุปกรณ์       

    1. ภาพใบมันส าปะหลังที่แสดงอาการเป็นโรคที่รวบรวมได้ 

    2. ซอฟต์แวร์ปรับแต่งภาพ  XnView รุ่น 2.49.5 

    3. ซอฟต์แวร์วิเคราะห์ภาพ ImageJ รุ่น 1.53 

    4. ภาษา Python 

    5. เครื่องคอมพิวเตอร์สมรรถนะสูง  

 
- วิธีการ  

1. การประมวลผลเบื้องต้น (Preprocessing)  
การทดลองนี้ใช้กลุ่มตัวอย่างภาพจากแฟ้มข้อมูลใบมันส าปะหลังที่เก็บรวบรวมได้ จ านวน 

500 ภาพ แบ่งข้อมูลภาพออกเป็น 5 คลาส ได้แก่ 0) ต้นปกติ 1) โรคใบไหม้ 2) โรคใบจุดสีน้ าตาล 3) โรคแอน
แทรคโนส และ 4) อาการใบด่าง คลาสละ 100 ภาพ รวมทั้งหมด 500 ภาพน าไปประมวลผลเบื้องต้นด้วย
โปรแกรม XnView ปรับเพ่ิมความคมชัด ตัดส่วนของภาพที่ไม่ต้องการออก ก าหนดขนาดภาพเท่ากับ 224 x 
224 พิกเซล และแปลงภาพจากระบบสี RGB เป็นภาพระดับสีเทา (Gray scale) โดยใช้สมการ   

 
 

2.  การสกัดข้อมูลตัวแปรจากภาพ (Feature Extraction) 
  โดยการวิเคราะห์ตัวแปรเชิงพ้ืนผิวภาพ (Texture analysis) ด้วยเมตริกซ์การปรากฎร่วม

ของระดับสีเทา (Gray – Level Co Occurrence Matrix : GLCM) (R.M. Haralick, 1979) ด้วยโปรแกรม
วิเคราะห์ภาพ ImageJ (ตารางที่ 1) GLCM ใช้ในการแปลความหมายของข้อมูลลักษณะพ้ืนผิวที่มนุษย์รับรู้ได้  
ให้อยู่ในรูปแบบของค่าทางคณิตศาสตร์ที่สามารถอธิบายถึงการกระจายตัวของพิกเซลของระดับสีเทา และ
ความสัมพันธ์ของต าแหน่งที่เกิดขึ้นในระนาบ 0, 45, 90 และ 135 องศา 

 
 

Gray = 0.299red + 0.587green + 0.144blue 
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      ตารางท่ี 1  ตัวแปร (Feature) ของภาพระดับสีเทาที่สกัดด้วยโปรแกรม ImageJ 
 

ตัวแปร (Feature) สูตร ความหมาย 
1. Contrast 

∑ 𝑃𝑖,𝑗 (𝑖 − 𝑗)2

𝑁−1

𝑖,𝑗= 0

 
i    ระดับสีเทา ตั้งแต่ 0 ถึง 255  
     พิกเซล (อ้างอิง) 
j    ระดับสีเทา ตั้งแต่ 0 ถึง 255  
     พิกเซล (ใกล้เคียง) 
N   จ านวนของระดับสีเทาบนวัตถุท่ี 
     สนใจ 

𝑃𝑖,𝑗 ความน่าจะเป็นของพิกเซล     
     ต าแหน่งแถวที่ i หลักท่ี j  
𝜇𝑖  ค่าเฉลี่ยระดับสีเทาพิกเซลอ้างอิง 
𝜇𝑗  ค่าเฉลี่ยระดับสีเทาพิกเซล 
     ใกล้เคียง   
𝜎𝑖  ค่าเบี่ยงเบนมาตรฐานค่าระดับ 
     สีเทาพิกเซลอ้างอิง 

𝜎𝑗  ค่าเบี่ยงเบนมาตรฐานค่าระดับ 
     สีเทาพิกเซลใกล้เคียง 
L   ค่าสเกลสูงสุดของค่าระดับสีเทา 

2. Correlation 
∑

(𝑖 − µ1)(𝑗 − µ2)

√𝜎𝑖
2 +  𝜎𝑗

2

𝑁−1

𝑖.𝑗=0

 

3. Entropy 
∑ 𝑃𝑖,𝑗 (− ln 𝑃𝑖,𝑗 )

𝑁−1

𝑖,𝑗= 0

 

4. Angular Second Moment 
(ASM) 
 

∑ 𝑃𝑖,𝑗
2

𝑁−1

𝑖.𝑗=0

 

5. Inverse Difference Moment 
(IDM) 

∑
𝑃𝑖,𝑗

1 + (𝑖 − 𝑗)2/𝐿

𝑁−1

𝑖.𝑗=0
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3. การสร้างโมเดลจ าแนกภาพโรคที่แสดงอาการใบมันส าปะหลัง 
 
 น าข้อมูลทั้งหมดมาใช้ในการสร้างโมเดลจ าแนกภาพโรคที่แสดงอาการใบมันส าปะหลัง (ภาพที่ 1) 
 

 
 

 
 
 
 
  

 

 

 

 

 

 

ภาพที่ 1  ขั้นตอนการสร้างโมเดลจ าแนกประเภท (classification) 

    การจ าแนกประเภท (classification) โดยใช้โมเดล Support Vector Machine (SVM) 
ภาษา Python บน Jupyter Notebook มีข้ันตอนดังนี้ 

    1. น าเข้าไลบรารีที่จ าเป็นต้องใช้ ได้แก่ numpy scipy scikit – learn matplotlib 

pandas pydotplus และ graphviz 

   2. โหลดข้อมูลจากแฟ้มข้อมูลภาพใบมันส าปะหลังที่รวบรวมไว้เข้ามาใน Kernel  

   3. ก าหนดคอลัมน์ที่เป็นตัวแปรต้น (Feature) และตัวแปรตาม (Class) 

   4. แบ่งข้อมูลออกเป็น 2 ส่วน คือ 

       1) ข้อมูลฝึก (Training data) เป็นส่วนที่ใช้ส าหรับการสร้างโมเดล 

ประมวล 
ผลภาพ 
เบื่องต้น การสกัดตัวแปร  

 

  
แบ่งคลาส 

ขั้นตอนวิธีของการ
เรียนรูด้้วยเครื่อง 

ข้อมูลภาพใหม ่

ตัวแปรจากภาพ 

โมเดล 
การจ าแนก 
ประเภท 

คลาสที ่
จ าแนกได ้
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       2) ข้อมูลทดสอบ (Testing data) เป็นส่วนที่ใช้ส าหรับการทดสอบประสิทธิภาพ

ของโมเดล 

   5. สร้างโมเดลด้วยเทคนิค SVM แบบ Non-linearly separable data 
   6. ทดสอบการจ าแนกประเภทด้วยข้อมูลทดสอบ จะได้ผลลัพธ์ที่จ าแนกได้ 
    7. ประเมินประสิทธิภาพของโมเดล โดยค านวณ Confusion Matrix คือตารางที่ใช้ใน

การวัดความสามารถของการเรียนรู้ด้วยเครื่องในการแก้ปัญหาการจ าแนกประเภท 

 
 

True Positive (TP) คือ สิ่งที่โมเดลท านายว่า “จริง” และมีค่าเป็น “จรงิ” 
True Negative (TN) คือ สิ่งที่โมเดลท านายว่า “ไม่จริง” และมีค่า “ไม่จริง” 
False Positive (FP) คือ สิ่งที่โมเดลท านายว่า “จริง” แต่มคี่าเป็น “ไม่จรงิ” 
False Negative (FN) คือ สิ่งทีโ่มเดลท านายว่า “ไม่จริง” แต่มีค่าเป็น “จรงิ” 

 
ตัววัดที่นิยมใช้กัน คือ 

1. ความแม่นย า (Precision) โดยพิจารณาแยกทีละคลาส 

  
 

2.  ความครบถ้วน (Recall)  โดยพิจารณาแยกทีละคลาส 

 
 

3.  ความถูกต้อง (Accuracy)  โดยพิจารณารวมทุกคลาส 
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4. F1-Score คือค่าเฉลี่ยแบบ harmonic mean ระหว่าง precision และ Recall 
 

F1 = 2 × 
(𝑃𝑟𝑒𝑐𝑖𝑠𝑖𝑜𝑛 × 𝑅𝑒𝑐𝑎𝑙𝑙)

(𝑃𝑟𝑒𝑐𝑖𝑠𝑖𝑜𝑛 + 𝑅𝑒𝑐𝑎𝑙𝑙)
 

 
- เวลาและสถานที่   

ระยะเวลาด าเนินการ ตุลาคม 2562 – กันยายน 2563 

สถานที่ด าเนินการ  แปลงเกษตรกรจังหวัดนครราชสีมา ปราจีนบุรี สระแก้ว 

ศูนย์เทคโนโลยีสารสนเทศและการสื่อสาร กรมวิชาการเกษตร กรุงเทพฯ 

 

8. ผลการทดลองและวิจารณ์ 

8.1 การประมวลผลเบื้องต้น  

                กลุ่มตัวอย่างภาพที่ใช้ในกระบวนการเรียนรู้ด้วยเครื่อง แบ่งเป็น 5 คลาส ได้แก่ 0) ต้นปกติ 1) 

โรคใบไหม้ 2) โรคใบจุดสีน้ าตาล 3) โรคแอนแทรคโนส และ 4) อาการใบด่าง ปรับเพ่ิมความคมชัด ตัดส่วน

ของภาพที่ไม่ต้องการออก ก าหนดขนาดภาพเท่ากับ 224 x 224 พิกเซล และแปลงภาพจากระบบสี RGB เป็น

ภาพระดับสีเทา (ตารางท่ี 2) 

ตารางท่ี 2  ภาพ RGB และภาพระดับสีเทา (Gray Scale) แบ่งตามคลาส 

คลาส ภาพ RGB ภาพระดับสีเทา 
จ านวน 
(ภาพ) 

ปกติ 

Healthy 

  

100 

ใบไหม้ 

CBB 

  

100 
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คลาส ภาพ RGB ภาพระดับสีเทา 
จ านวน 
(ภาพ) 

ใบจุดสีน้ าตาล 

CBSD 

 

  

100 

แอนแทรคโนส 

CA 

  

100 

อาการใบด่าง 

CMD 

  

100 

 

8.2 การสกัดข้อมูลตัวแปรจากภาพ  

       โดยการวิเคราะห์เมตริกซ์การปรากฎร่วมของระดับสีเทา (GLCM) และบันทึกเป็นไฟล์ csv   

(ตารางท่ี 3) 

  ตารางท่ี 3  ตัวอย่างข้อมูลตัวแปรที่สกัดได้จากภาพโรคท่ีแสดงอาการใบมันส าปะหลัง 

Contrast Correlation Entropy ASM IDM Pic Disease 
1469.361 0.000318 8.9781 0.000611 0.05733 h0001.jpg 0 
905.7664 0.000356 8.9193 0.000247 0.08351 bl0001.jpg  1 
594.2592 0.000369 8.6073 0.001065 0.12300 bs0001.jpg  2 
1263.258 0.000244 9.2533 0.000962 0.08416 an0001.jpg  3 
424.7333 0.000341 7.9440 0.006929 0.23300 mv0001.jpg  4 
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8.3 การสร้างโมเดลจ าแนกภาพโรคที่แสดงอาการใบมันส าปะหลัง 
สร้างโมเดลจ าแนกภาพโดยการเรียนรู้ด้วยเครื่อง ใช้ภาษา Python บน Jupyter Notebook 

เลือกใช้ไลบรารี SVM ของ Scikit-Learn และทดสอบประสิทธิภาพโมเดลโดย Confusion Matrix มีค่า
ความถูกต้อง (accuracy)  66 เปอร์เซ็นต์ (ตารางที่ 4) 
 

     ตารางท่ี 4  ค่าวัดประสิทธิภาพของโมเดลจ าแนกภาพโรคที่แสดงอาการใบมันส าปะหลัง 
class precision Recall f1-score support 

0 1.00 0.24       0.38         21 
1 0.00 0.00 0.00 54 
2 0.65       0.93      0.77       302 
3        0.80 0.62 0.70 26 
4 0.68 0.43 0.53 160 

accuracy  0.66 563 
macro avg 0.63 0.44 0.47 563 

weighted avg 0.62 0.66 0.61 563 
     

9. สรุปผลการทดลองและข้อเสนอแนะ :  

จากการเรียนรู้ด้วยเครื่อง ได้โมเดลการจ าแนกโรคที่แสดงอาการบนใบมันส าปะหลัง มีค่าความ

ถูกต้อง 66  เปอร์เซ็นต์ สามารถน าไปใช้ประโยชน์ในการพัฒนาโมเดลด้วยอัลกอริทึมอ่ืนๆ ต่อไป 

 

10. การน าผลงานวิจัยไปใช้ประโยชน์  

ได้โมเดลการจ าแนกโรคที่แสดงอาการบนใบมันส าปะหลังด้วยเทคนิคการประมวลผลภาพดิจิทัล 

นักวิจัยสามารถใช้เป็นข้อมูลพื้นฐานในการศึกษาเพ่ิมเติมพัฒนาโมเดลในพืชอ่ืนๆ เพ่ือช่วยเหลือเกษตรกร และ

เจ้าหน้าที่ในการวินิจฉัยโรคพืชเบื้องต้นต่อไปได้ 

 

11. ค าขอบคุณ : 

งานวิจัยนี้เป็นส่วนหนึ่งของแผนวิจัยและพัฒนาระบบสารสนเทศสู่เกษตรดิจิทัล ขอบคุณเกษตรกร

แ ป ล ง มั น ส า ป ะ ห ลั ง  ผู้ เ ชี่ ย ว ช า ญ ด้ า น เ ท ค โ น โ ล ยี แ ล ะ ร ะ บ บ ส า ร ส น เ ท ศ  น า ย อิ สิ วั ฒ น์   

บัณฑราภิวัฒน์ ที่ให้ค าแนะน า ปรับแก้งานวิจัยนี้เพ่ือให้ เกิดประโยชน์แก่ผู้เกี่ยวข้อง ขอบคุณผู้อ านวยการ

ศูนย์วิจัยและพัฒนาการเกษตรจังหวัดปราจีนบุรี เจ้าหน้าที่กรมส่งเสริมการเกษตร เกษตรอ าเภอวังน้ าเขียว 

รวมทั้งพนักงานราชการทุกต าแหน่ง ที่ให้ความร่วมมือในการเก็บข้อมูลเป็นอย่างดี ท าให้งานวิจัยนี้ส าเร็จลุล่วงได้ 
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13. ภาคผนวก 
          13.1 การใช้โปรแกรมตกแต่งภาพ XnView   
        1) ดาวนโ์หลดไฟล์ติดตั้งที ่https://www.xnview.com/en/ เลือก XnView 2.49.5 for Windows 

 
 

       2) การเปลี่ยนชื่อภาพ เลือกภาพที่ต้องการ แลว้ไปที่เมนู Tools > Batch Rename … 
เลือกเปลีย่นชื่อ new template เช่น health####  กดปุ่ม Rename 

 
  

  3) การเปลี่ยนขนาดภาพ และแปลงเปน็ภาพระดับสเีทา  
- เลือกเมนู Tools > Batch Processing … แล้วไปทีแ่ท็บ Transformation เลือก image >  

Resize กด add > แล้วเติมขนาดภาพ Width: 224 Height: 224  
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- ทีแ่ท็บ Transformation เลือก Convert > Convert to Greyscale กด add > แล้วเติม  
Parameters : 8 
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- คลิกปุ่ม Go โปรแกรมจะเปลี่ยนขนาดภาพและแปลงภาพระดับสีเทาอย่างต่อเนื่องจน 
ครบทุกไฟล์ 

 

 
 
13.2 การใช้โปรแกรมวิเคราะห์ภาพ ImageJ  
       1) ดาวนโ์หลดไฟล์ติดตั้งที่ https://imagej.nih.gov/ij/download.html เลือก platform  
ตามต้องการ 
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2) ด า ว น์ โ ห ล ด ไ ฟ ล์  Plugin Texture Analyser ที่  https://imagej.nih.gov/ij/ 
plugins/texture.html โดยคัดลอก GLCM_Texture.class ไปไว้ที่โฟลเดอร์ plugins แล้วรีสตาร์ท
โปรแกรม ImageJ ถ้าต้องการท าหลายไฟล์ ให้คัดลอก Batch_GLCM_Measure.txt ไปไว้ที่โฟลเดอร์ 
macros 

 

 
 

3) การสกัดข้อมูลตัวแปรจากภาพด้วยมาโคร Batch GLCM Measure 
- คลิก plugins > Macros > install เลือกไฟล์ Batch_GLCM_Measure.txt กดปุ่ม Open 
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- ใช้งาน Batch GLCM Measure คลิกท่ี Plugins > Macros > Batch GLCM Measure 

เลือก Directory ที่ต้องการสกัดข้อมูลตัวแปร แล้วกดปุ่ม Select 

 
 

- เลือก ขนาดพิกเซลทีจ่ะด าเนนิการทีละข้ัน กด OK 

 
 

- ได้ผลลัพธ์ที่หนา้จอ Log  คลิก File > Save As ... ตั้งชื่อไฟล์ แลว้กด Save 
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13.3 การเรียนรู้ด้วยเครื่องแบบมีการฝึก (Supervised Learning) ใช้การโปรแกรมภาษา  
Python บน Jupyter Notebook 

 
ติดตั้ง Miniconda 

ดาวนโ์หลดตวัติดตั้งล่าสุดที ่https://conda.io/miniconda.html  
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ติดตั้ง Jupyter Notebook  
เปิดหน้าต่าง Anacoda Poweshell Prompt (miniconda3) 
 

conda install -c conda-forge notebook 

ติดตั้งไลบรารีที่จ าเป็น 
เปิดหน้าต่าง Anacoda Poweshell Prompt (miniconda3) ติดตั้ง Package หรือ Library ที่จ าเป็นให้

เรียบร้อย 
 

conda install numpy scipy pandas matplotlib hdf5 pillow scikit-learn  
conda install -c conda-forge feather-format 

 
การเรียนรู้ด้วยเครื่องแบบมีการฝึก (Supervised Learning) 
 
 เปิดใช้งาน Jupyter notebook  

jupyter notebook 

 
 
เลือก New > python3 
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ป้อนค าสั่งภาษา Python ในช่อง  

 

แล้วกด  เพื่อดูผลลัพธ ์

 
1. Import Library 

 

import numpy as np 
import matplotlib.pyplot as plt 
import pandas as pd 

 
2. Import Data 

 

dataset_url = "E:\cassava.data.csv" 
feature = ["Contrast", "Correlation", "Entropy", "ASM", "IDM", "Disease"] 
cassava_data = pd.read_csv(dataset_url, names = feature) 
print ("Dataset Lenght:: ", len(cassava_data)) 
print ("Dataset Shape:: ", cassava_data.shape) 
cassava_data.head() 

 
3. Set up Data and Labels 
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ก าหนดให้คอลัมน์ “Disease” คือ ตัวแปรที่บอกชื่อโรคที่แสดงอาการบนใบมันส าปะหลัง เป็นตัวแปร 
ตาม (Class) และให้คอลัมน์ที่เหลือเป็นตัวแปรต้น (Feature)   

 

X = cassava_data.drop("Disease", axis=1) 
y = cassava_data[("Disease")] 

 
4. Split dataset into test and train data 
      แบ่งข้อมูลออกเป็น 2 ส่วน โดยการสุ่ม (random) แบ่งเป็นข้อมูลฝึก (Training Data) 75% และ 

ข้อมูลทดสอบ (Test Data) 25% 
 

from sklearn.model_selection import train_test_split 
X_train, X_test, y_train, y_test = train_test_split(X, y, train_size=0.75,test_size=0.25, 
random_state=100) 

 
การปรับสเกลของข้อมูล  

from sklearn.preprocessing import StandardScaler 
scaler = StandardScaler() 
X_trainscaled = scaler.fit_transform(X_train) 
X_testscaled = scaler.fit_transform(X_test) 
print(X_trainscaled[:5, :]) 
print(X_testscaled[:5, :]) 

 

print("All x Train  has mean of:", X_trainscaled.mean(axis=0)) 
print("All x Train has standard deviation of:", X_trainscaled.std(axis=0)) 
print("All x Test has mean of:", X_testscaled.mean(axis=0)) 
print("All x Test has standard deviation of:", X_testscaled.std(axis=0)) 

 
5. Fitting Model ใช้ SVM แบบ Non-linearly Separable Data 

 

from sklearn.svm import SVC 
svclassifier = SVC(kernel='rbf') 
svclassifier.fit(X_trainscaled, y_train) 
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6. Prediction 

 

y_pred = svclassifier.predict(X_testscaled) 

 
7. Evaluation 

 

from sklearn.metrics import classification_report, confusion_matrix 
print(confusion_matrix(y_test, y_pred)) 
print(classification_report(y_test, y_pred)) 
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